
Accessing URLs Directly

With Quarterdeck Mosaic, you can navigate to any location if you know its ‘address’ (or URL, Uniform 
Resource Locator). 

1.      Select Go To on the Toolbar or the Navigation menu or Open from the File menu.    

(If you currently have an open browser window on the desktop and the URL field is displayed, you
can just click in the URL field, type in the URL, and press Enter.)

The Go To URL or Open URL dialog box appears.    

2.      Specify whether the document should open in a new window or replace the contents of the 
current window.    By default, the new document replaces the current document, if one exists.

If the URL refers to a document on your local hard drive or a drive accessible to you over a local 
area network, you can use the Browse button to search for it.    When you click the Browse 
button, a standard Windows browse box is displayed.

3.      Type the URL in the field above Uniform Resource Locator, then click OK.

Quarterdeck Mosaic now takes you directly to the address you specified.    

If you attempt to connect to a site that uses the Basic Authentication security scheme to control 
access, a User Authentication Required dialog box is displayed.    You must then provide a pre-
established username and password to gain access to the site.
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Action
After selecting a file type from the scroll box (or using the New button to add a type not listed) and typing 
in one or more extensions used by files of this type, select from the following list the action you want 
Quarterdeck Mosaic to take when it encounters a URL of that type.

External Viewer Application
Instructs Quarterdeck Mosaic to spawn an external viewer when it encounters a URL of this file type.    
When you select this option for a file type, enter the program you want Quarterdeck Mosaic to run in the 
field which appears below, including the full path to the program.    Use the Browse button, if necessary, 
to locate the program’s executable file.



Action
After selecting a file type from the scroll box (or using the New button to add a type not listed) and typing 
in one or more extensions used by files of this type, select from the following list the action you want 
Quarterdeck Mosaic to take when it encounters a URL of that type.

Quarterdeck Viewer
The file is displayed using one of Quarterdeck Mosaic’s internal viewers.    This option is only available for 
plain text files, HTML documents, .GIF, JPG, and .XBM images, and .WAV, .AU, and .AIFF sound files.



Action
After selecting a file type from the scroll box (or using the New button to add a type not listed) and typing 
in one or more extensions used by files of this type, select from the following list the action you want 
Quarterdeck Mosaic to take when it encounters a URL of that type.

Save to disk
Quarterdeck Mosaic displays the Save As dialog box asking you to specify a filename as well as the 
location where you want to save the file.



Action
After selecting a file type from the scroll box (or using the New button to add a type not listed) and typing 
in one or more extensions used by files of this type, select from the following list the action you want 
Quarterdeck Mosaic to take when it encounters a URL of that type.

Unknown, Prompt User
Unknown Mime Type dialog box appears,    asking you how to proceed.    This action is the default for any 
file type not currently listed on the Data Engine page of the Preferences notebook.



Adding Annotations

Quarterdeck Mosaic lets you add personal notes to a document as you view it and save those comments 
to a file on your system.    Your comments, called annotations, can then be viewed and edited any time 
you view the associated document.    You can move an annotation from one location to another within a 
document or copy text from an annotation to another location. There is no limit to the number of 
annotations you can create on a given document.

You need not save a document on your local system in order to later view annotations that you created 
when viewing it.    Whenever you revisit the same URL, your annotations can be displayed. Regardless of 
whether annotations are associated with a remote document or one that exists on your local system, the 
annotations themselves reside on your local hard drive.    For this reason, your personal annotations can 
only be read by you or someone using your computer.

Note:      In order to display annotations, the Annotations option must be enabled in the Preferences 
notebook.    With this option disabled, you can create (but not view) annotations.

To create an annotation for the current document:

1.      Right click at the point where you want the annotation to appear.

2.      Select Annotation from the pop-up menu that appears.

The Edit Annotation dialog box displays.

3.      Type your comments, then click OK.

An annotation icon appears where you displayed the pop-up menu, indicating that an annotation 
exists.

To view an existing annotation:

1.      Click the annotation icon that appears within the document.

2.      After viewing your notes, press Esc or click outside the boundaries of the annotation to remove it
from the screen.

To edit an annotation:

1.      Right click the annotation icon to display the pop-up menu, then select Edit Annotation.

2.      Edit the text as desired, then click OK.

To delete a previously saved annotation:

1.      Right click the annotation icon to display the pop-up menu, then select Delete Annotation.    (If 
the Edit Annotation dialog box is displayed, select Delete Annotation.)

A dialog box appears, asking you to verify that you want to delete the annotation. 

2.      Select Yes to proceed with the deletion or No to cancel the request.



Tip:      If you remember adding annotations to a document but don't see them when viewing the 
document, check Preferences to verify that Annotations are enabled.
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Advanced Navigation

You probably began your exploration of the Internet by using the Hotlists included with Quarterdeck 
Mosaic and by following links to other sites.    Suppose, however, you are reading a newspaper or 
magazine and come across a reference to a Web site that sounds interesting.    Can you get there without
jumping from link to link?    Of course you can!    

When you travel to a strange city, you do not need to know the layout of the city to get where you want to 
go.    You simply flag down a taxi and give the driver the address.    With Quarterdeck Mosaic, you can 
navigate just as easily to any location if you know its address (or URL, Uniform Resource Locator). 

Accessing URLs Directly
The URL Helper
Understanding URLs
Searching the Web
FTP and Gopher
Newsgroups
Sending Email Messages



Anatomy of a URL

URLs include the scheme used to access the site, the name of the host computer, and the name of the 
document to be displayed.    Below is a typical URL:

http://biomed.nus.sg/MOE/sch/news1.html

In this example, the scheme is ‘http’, the host computer is ‘biomed.nus.sg’, and the document name is 
‘/MOE/sch/news1.html.’    

Many URLs include only the scheme and the name of the remote server, followed by a slash. (Note that 
URLs require forward slashes, not backslashes.)    When you access such a site, you are presented with 
a document that has been configured by that system’s WebMaster (or System Administrator) as a base 
document or Home Page. The following URL takes you to the Home Page of Quarterdeck’s WWW site 
(which, in addition to providing information about the latest Quarterdeck products, contains links to rich 
databases of information available on computer systems around the world):    

http://www.qdeck.com/
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Browse, Import-Export, and Save As Dialog Box

When you instruct Quarterdeck Mosaic to save or load a file or to export or import URLs in a Hotlist or 
HTML document, a dialog box similar to the one above displays.

Choose a file type from the Save File as Type or List Files of Type drop-list. (The available file types will
vary, depending on the activity you are performing.)

If you are loading a file from disk or importing URLs from a document, search for the file by selecting a 
drive (from the Drives drop-down list) and a directory (by double-clicking on a directory's mini-folder icon 
under Directories).    When you find the file you want, select it and click OK.    

If you are saving a file or exporting URLs from a Hotlist to a file, select the drive and directory where you 
want to save the file, enter a filename for the new file in the File Name field, then click OK.



Browser

Show Browser Margins
If this option is enabled, a grey border appears around a document, giving it a three-dimensional look.    
When margins are visible, a document resembles a sheet of paper sitting on a desk.

Show Page Turners
When Page Turners are enabled, you can click icons in the upper-left and -right corners of a document to 
move backward and forward through the documents that have been displayed in a browser window.

Show Annotations
This option determines whether annotations are visible within your documents.

Show URL Field
If this option is enabled, the URL address of each document is displayed at the top of its browser window.

Show URL Helper
If this feature is enabled, a Show URL Helper button appears at the top of each browser window.

Wipe Interval in Milliseconds
This feature determines how quickly a document is erased from a browser window when you navigate 
backward to the previous document.    To disable the effect altogether, set this to 0.

Background Color
This option determines the background color of your browser windows.
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Cache

Cache Enabled
By allowing Quarterdeck Mosaic to use a portion of your available hard drive space as a cache, or 
temporary storage area, performance is greatly improved.    By clicking in the check box, you can enable 
or disable this feature.

Maximum Cache Size
You can set a maximum cache size (in K) based on the amount of free space of your hard drive.    By 
default Quarterdeck Mosaic will use a maximum of two megabytes (2048K) of disk space for a cache.    To
specify a number other than the default, type it into this field.

NOTE:    If you need to free up some disk space - for example, if another Windows application is unable to
complete a task due to insufficient disk space - you can manually delete the contents of 
Quarterdeck Mosaic's cache.    It is important, however, that you first close down the program, 
then delete the file PERSINST.ENT in addition to all of the data files in your \CACHE subdirectory,
one level below your Quarterdeck Mosaic directory.    After deleting the files in the cache, restart 
Quarterdeck Mosaic.    Do not delete any of these files while the program is running, and do not 
delete data files unless you also delete PERSIST.ENT.    (This can result in errors when 
attempting to retrieve documents from remote sites.)

Maximum Number of Concurrent Connections
Quarterdeck Mosaic is capable of multitasking, or retrieving multiple documents simultaneously, and this 
feature can be a real boon to productivity.    There are situations, however, in which you may want to limit 
the number of concurrent connections you allow the program to make.    For instance, if you attempt to 
download six large files simultaneously using a 14,400 modem to communicate over a standard 
telephone line, networking activity is split among the six documents, and each document is actually being 
downloaded at 2400 baud!    Another reason to limit connections is netiquette -- commonly accepted 
rules of online behavior.    Keep in mind that an Internet site is limited to a certain number of connections 
at any one time.    If you use several connections at once, you may be preventing others from connecting 
at all! 
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Canceling a Download

Occasionally you may want to stop a download before it completes.    For instance, you may realize as a 
document is being displayed that you are not interested in viewing it, or a file may be larger than you 
expected, requiring more time to download than you are willing to invest.      

To cancel a download:

1.      Select Stop from the Toolbar or Stop Current Read from the Navigate menu.

The animation should stop within a few seconds.
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Change Icon Dialog Box

Use the Browse button to search your hard drive for the icon you want to assign to an object, then 
highlight the icon    to select it and click OK.



Choose Font Dialog Box

To change the font used for a style, highlight the style and click Choose Font.    The Choose Font dialog 
box appears with the style listed in the title bar.

Select the font you want to use from the Font list, then select a Font Style and Size from those lists.    
Select any Effects you want to implement for the style, and select a color other than the default black, if 
desired, from the Color  list.

As you make selections, the Sample box shows you what the font will look like.    When you are satisfied 
with your choices, click OK.



Comment
You can use this field to store personal notes regarding a specific file type.      Highlight an entry in the 
Type/Subtype list, then type your remarks in the Comment field.



Components of Quarterdeck Mosaic

In order to take full advantage of Quarterdeck Mosaic’s many features, you must understand how the 
various components of the program (and the World Wide Web) work.    Let’s take a look at them now.

Toolbar

Toolbar Animation

Archives

Desktop

Browser Windows

Home Page

URL Field

URL Helper

Status Bar
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To the left of the desktop is a tabbed notebook with four pages called the Archives pane.    To display any 
page, click on its tab. The Archives contains the following pages:

The Hotlists page lists all of your Hotlists -- collections of URLs grouped into folders.    Each 
hotlist is represented by a mini-folder icon with a text description to the right and a plus (+) or 
minus (-) sign to the left.    By clicking on a plus sign you expand the contents of that folder, 
displaying the documents contained within it.    When a hotlist opens, the plus sign changes to a 
minus sign, and clicking on any document within the folder causes it to be displayed within a 
browser window.    Click the minus sign to contract the hotlist.

The Global History page list sites you have visited during a specifed length of time.    (The length
of time that sites remain in the Global History is specified in the Preferences Notebook.)    

The Local History page lists sites visited in the current browser window, and its contents change 
when you switch to another window. 

The Link Tree page shows links which are connected to the currently displayed document.    



Documents are displayed in standard, moveable, resizable, windows in the desktop area of the screen.    
Depending on the method you use to select a document, it will either be displayed in a new browser 
window or replace the contents of a window that is already open.    Browser windows can be placed in a 
tiled or cascading arrangement or moved and resized to suit your personal preferences.    Documents can
also be maximized, in which case each document covers the entire Quarterdeck Mosaic desktop area.



The largest portion of Quarterdeck Mosaic’s display is taken up by the desktop, a large, empty area in 
which documents are displayed. 



During startup Quarterdeck Mosaic loads a file referred to as a Home Page (unless you specifically 
instruct it not to do so).    A Home Page is a convenient starting point for your explorations.    A local Home 
Page is a file that resides on your local hard drive.    During installation a local Home Page is copied into 
the Quarterdeck Mosaic directory on your hard drive.    By default this local file is displayed when the 
program starts.    Alternately, you can instruct Quarterdeck Mosaic to display a different local document, a 
remote document (a file on another computer system), or to display no document at all.



Along the bottom of the program display is the Status Bar.    Quarterdeck Mosaic uses this area to keep 
you informed about tasks being performed.    The left side of the Status Bar describes user activity while 
the right side details network activity, such as attempts to connect to sites or the transferring of 
documents.    As you move the cursor around the display, the name of the file or URL at the current cursor
position appears in the left portion of the Status Bar.    As you retrieve documents, the progress of the 
transfer can be monitored in the right portion of the Status Bar.    When a transfer completes, the message
"Document Done" appears.    If you prefer to use this area to view more of your document, you can 
disable the Status Bar.



The Toolbar is a row of buttons that give you quick access to frequently performed tasks. You can 
configure the Toolbar to use any one of five styles of buttons:    large icons with or without titles (text 
descriptions), small icons with or without titles, or titles only.    You can change the style of the Toolbar 
buttons on the General Options page of the Preferences notebook or by right-clicking on an empty area of
the Toolbar to display its pop-up menu, then selecting the style you prefer. 

You can also move the Toolbar from its default location to another area of your screen by positioning the 
cursor over any non-button area of the Toolbar and dragging it to the new location.    (The cursor is in the 
proper position for dragging when it changes to a hand.)    You can anchor the Toolbar to the top, bottom, 
right or left side of the Quarterdeck Mosaic display or it can float over the program’s display or your 
Windows desktop.    To reattach the Toolbar to either the top or bottom of the display, place the cursor on 
the non-button area and drag into place.    (When the Toolbar is in the correct position for docking, an 
outline appears along the border of the display.)

The Hotlist, Save, and Trash buttons are Windows "drop sites."    That is, you can perform the associated 
function on any document by dragging the document to the button and dropping it within the button’s 
borders. 



At the right end of the Toolbar is an animated graphic.    When Quarterdeck Mosaic is communicating with 
a remote site or loading a document from your local drive, the icon becomes animated.    When the 
animation stops, the program is no longer performing network activity.



By default, the URL (or network name) of each document is displayed at the top of the browser window.    
If you prefer to use this area to view more of your document, you can disable this feature.



Quarterdeck Mosaic’s URL Helper assists you in creating legal URLs by providing a template from which 
you can work.    The URL Helper guides you by showing you which pieces of information are required for 
the particular protocol you wish to use as well as by verifying that the information you enter uses the 
correct syntax.    (The URL Helper cannot verify that the URL you enter is available, only that you 
"followed    the rules", so to speak, when entering the address.)

The URL Helper is available on the Go To URL dialog box (which appears when you select Go To from 
the Toolbar or the Navigate menu) and the Open URL dialog box (displayed when you select Open from 
the File menu.)    It also appears at the top of each browser window, unless you turn off this feature 
through the Preferences notebook. 



Configuring Quarterdeck Mosaic

A myriad of configuration options are available in Quarterdeck Mosaic.    By selecting Preferences under 
the Tools menu you can enter your personal networking information as well as change the look of the 
program to suit your taste.    

When you select Preferences, a tabbed notebook appears with options grouped together by category.    
To change the options on a given page, click on its tab.    The following options are available in the 
notebook.    If you are unsure about options in the Network category, you may want to check with your 
Network Administrator.    

HTML Viewer
GIF Viewer
Cache
Data Engine
General
Global History
Browser
Fonts



Confirm Change Hotlist Dialog Box

When you select the Set As Current option from the Hotlist menu, the above dialog box is displayed.    

To verify that you want to change your current Hotlist as indicated on the dialog box, select Yes.    If this is 
not what you want to do, select No to cancel the operation.



          Quarterdeck Mosaic
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Advanced Navigation
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Configuring Quarterdeck Mosaic
Troubleshooting

For Help using the online Help, press F1.



Create a New MIME Type Dialog Box

For more information on configuring Quarterdeck Mosaic to handle new file types, click on any field in the 
Create New MIME Type dialog box below.



      Quarterdeck Mosaic Online Help      
                          Designed and Written       
                                                      by
                                       Kathy Hand



Data Engine

As you explore the Web, you will come across documents containing graphics images, sound clips, 
movies, etc.    Quarterdeck Mosaic contains an internal viewer capable of displaying plain text files, HTML 
documents, .GIF, JPG, and .XBM images.    Quarterdeck Mosaic can also play .WAV, .AU, and .AIFF 
sound files. To view other types of files you must configure the program to launch external viewers.    

Using the Data Engine page of the Preferences notebook, you can create a new MIME type by 
associating the file extension with a specific type of file and with the action you want Quarterdeck Mosaic 
to take when it encounters a file of that type. 
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Edit Annotation Dialog Box

Type the information you want to include in the annotation, pressing Enter at the end of each line.    When
you are done, click OK.



Edit Commands

Alt + E, T 
[or Ctrl +
X]

Deletes a block of text and 
place it in the Windows 
clipboard.

Alt + E, C 
[or Ctrl +
C]

Copies a block of text to the 
Windows clipboard.

Alt + E, P 
[or Ctrl +
V]

Copies a block of text from 
the Windows clipboard.

Alt + E, D 
[or Del]

Removes a block of text from 
an input field.

Alt + E, F 
[or Ctrl +
F]

Searches the current 
document for a string of 
characters.

Alt + E, N 
[or F3]

Searches the current 
document for the next 
occurrence of a string of 
characters.

Alt + E, A Edits an existing annotation 
or adds an annotation if none 
exists.

Alt + V, O, A Adds a new annotation to a 
document with existing 
annotations.
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Edit Menu

Cut        [Alt+E, T] or [Ctrl+X]
Deletes a selected block of text from an input field (such as the URL field on a browser window) and 
stores it in the Windows clipboard.    (You cannot cut text from a document.)

Copy      [Alt+E, C] or [Ctrl+C]
Copies a selected block of text from the current document to the Windows clipboard. 

Paste      [Alt+E, P] or [Ctrl+V]
Places the contents of the Windows clipboard into an input field (such as the URL field on a browser 
window) at the point where the cursor is located.    (You cannot paste text into a document.)

Delete      [Alt+E, D] or [Del]
Removes a block of text from an input field (such as the URL field on a browser window).

Find      [Alt+E, F] or [Ctrl+F]
Searches the current document for a particular string of characters.    When you choose Find, a dialog
box appears and you can enter search criteria.    

Find Next      [Alt+E, N] or [F3]
Searches for the next occurrence of a character string within a document.    

Annotation      [Alt+E, A]
Allows you to add a personal note (annotation) to the current document or alter an existing 
annotation.    

Return to The Menu Bar



Exploring Quarterdeck Mosaic

The best way to learn about the Web - and about Quarterdeck Mosaic - is to dive in and start exploring.    
To that end, we will travel to one of the sites listed in the preconfigured hotlists that were installed along 
with the program.      In order to use the included Hotlists in this section, you must be connected to the 
Internet, rather than running on a local network.

Note:        The information in this section was accurate at the time our manual went to press.    Because 
the Web is constantly changing, the documents you see online may differ from those    described 
below.    If a particular document has changed, the actions described below can be used on most 
documents available on the Web.

Taking That First Step
Retracing Your Steps
Returning to Your Home Page
Canceling a Download
Mouse, Menus, or Keyboard?
Toolbar Button Drop-Sites



Filename Extensions
Extensions refers to the file extension (or extensions) used by files of this type and subtype.



FTP and Gopher

FTP and Gopher are popular, easy-to-use tools for navigating the Internet.    Both access methods, when 
used in Quarterdeck Mosaic, use a menu-driven system to move through hypertext links, allowing you to 
access data without the use of cryptic commands.    

As you move about on the Internet you will encounter links that jump to FTP and Gopher sites.    Because 
the capability to access such sites is seamlessly integrated into Quarterdeck Mosaic, you need not be 
concerned with the fact that you are using FTP or Gopher.    If you learn of a particular FTP or Gopher site
that you wish to visit, you can access it by using the URL Helper and typing in the appropriate information.

Note:        Quarterdeck Mosaic’s FTP allows one-way transfers only. You can download from but not 
upload to remote sites.    A full-featured FTP program utilizing a graphical user interface is 
available as part of Quarterdeck’s complete suite of Internet tools.
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File Commands

Alt + F, O Opens a new URL in a 
browser window.

Alt + F, C Closes the current browser 
window.

Alt + F, A Saves the current document 
to disk.

Alt + F, R Retrieves a new copy of the 
current document.

Alt + F, T Displays the Properties dialog
box for the current document.

Alt + F, P Prints the current document.

Alt + F, V Displays a full-page image of 
the current document as it will
appear when printed. 

Alt + F, S Displays the printer setup 
dialog box.

Alt + F, X Exits Quarterdeck Mosaic.

Return to Keyboard Commands



File Menu

Open      [Alt+F, O]
Retrieves a document and displays it in a browser window.    By default, the document opens in the 
current browser window.    However, the Open URL dialog box which appears when this option is 
selected includes an Open in New Window check box.    If you check this box, the document opens in 
a new window.    The Open option is comparable to Go To on the Navigation menu and the Toolbar. 

Close      [Alt+F, C]
Closes the current browser window.

Save As      [Alt+F, A] 
Saves the contents of the current browser window to disk.    Using this option, a document can be 
saved as plain text or HTML and a Hotlist as an HTML document.    When you select Save As, you 
are presented with a dialog box which prompts you for a filename and location where the file is to be 
saved.    Save As on the File menu is comparable to the Save button on the Toolbar.    

Reload      [Alt+F, R]
Instructs Quarterdeck Mosaic to again retrieve the current document.    This feature is useful in cases 
where a document is frequently updated or when Quarterdeck Mosaic was unable to retrieve one or 
more graphic images contained in a document.    Selecting Reload on the File Menu is equivalent to 
clicking on the Reload button on the Toolbar.

Properties      [Alt+F, T]
Displays a Properties dialog box for the current document and provides identifying information 
including URL, title, and file type.    In some cases additional information, such as the time and date 
that the file was last altered, is also shown.    The Properties dialog box also allows you to assign an 
icon to the URL.

Print      [Alt+F, P]
Prints the current document.    When you select this option, a standard Windows Print dialog box is 
displayed.    

Print Preview      [Alt+F, V]
Presents a full-page image of the current document as it will look when printed.

Print Setup      [Alt+F, S]
Allows you to specify typical Windows printer options such as the specific printer to use, paper 
orientation, and paper size.    The Print Setup dialog box appears when you select this option. 
Selecting the Options button on the Print Setup dialog box brings up the Options dialog box from 
which you can adjust dithering and intensity.    

Exit      [Alt+F, X]
Exits Quarterdeck Mosaic.
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Find Dialog Box

In the Find What: field, enter the text you want Quarterdeck Mosaic to search for in the current 
document.    

Check Match Case if you want Quarterdeck Mosaic to find only those occurrences of the string that 
match the exact mixture of uppercase and lowercase, as entered in the Find What: field.

Select Up or Down in the Direction field to specify the direction in which Quarterdeck Mosaic should 
search for the text.    

After entering the search string and selecting other options as desired, click Find Next to begin the 
search.    When Quarterdeck Mosaic encounters the text, it stops searching and highlights the string.    To 
search for the next occurrence, click Find Next again.



Fonts

These options control the fonts that are used when displaying documents in Quarterdeck Mosaic.    

A Style is a category of text as defined by the author of an HTML document.    For instance, certain 
passages of text are tagged (or designated) by the author as being "Heading" text.    When your browser 
displays "Heading1" text, it uses the font that you have specified for this style.    (Any text in an HTML 
document that is not designated by the author as a special style is displayed as "Normal" style.) 

A Scheme is a collection of styles that are used together. You can create a new scheme by selecting Add
New Scheme and entering a name for the new scheme.    To change the font for any style within a 
scheme, select the scheme from the drop-down list, highlight the style you want to change, and select 
Change Style Font.      From the dialog box that appears, choose the characteristics you want to assign 
to that style.    To remove a scheme from the list, select it from the droplist, then click Delete Scheme.

Color Options

Text
The default color for all text other than hypertext links is black.    You can assign a different color to a 
particular style of text by highlighting the style, then selecting a color from the drop-down list of colors.

Link
This option allows you to specify a color to be used when displaying hypertext links within documents.
The default color is blue.

Link Visited
This option allows you to specify a color to be used when displaying previously visited hypertext links. 
This option affects links that you have visited within the period of time set in the "History entries expire
after" option on the Global History page of the Preferences notebook. The default color is purple.
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GIF Viewer

Interlace Method

With this option you can instruct Quarterdeck Mosaic to use one of three different methods --    Precise, 
White Banded, or Smeared -- to display interlaced .GIF files as they are received by your system.    Each
option presents the partially downloaded image in a different style.    We suggest that you experiment with
each of the available Interlace methods and select the one you find the most pleasing.
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General

Load Home Page on Startup
This setting determines whether or not Quarterdeck Mosaic loads a Home Page at startup.    If you prefer 
that a Home Page not load during startup, remove the check from this option’s check box.

Home Page
This option tells Quarterdeck Mosaic which URL to load as your Home Page when you start the program 
or select Home from the Toolbar.

Use Current
Select this button to configure Quarterdeck Mosaic to use the current document as your Home Page.

URL Helper
Use the URL Helper button to find a local document that you want to designate as your Home Page.

Toolbar Icon Settings
This option lets you configure the Toolbar in one of five styles:    

Titles Only
Small Icons and Titles
Small Icons Only
Large Icons Only
Large Icons and Titles

Printing
Print Headers instructs Quarterdeck Mosaic to print a document's URL in the top margin. 
Print Footers causes Quarterdeck Mosaic to print page numbers in the bottom margin.
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Global History

By default, all documents viewed with Quarterdeck Mosaic remain on the Global History list for seven 
days. If you prefer, you can specify varying lengths of time for different file types to remain in the History.   

History Entries Expire After
In this field you set the number of days that URLs remain in the Global History before they are deleted.    If
you prefer that URLs not be deleted from the Global History list after a set period of time, click in the box 
next to Never.

Total Number of Items Allowed
Using this field, you can specify the maximum number of items that should remain on the Global History 
page of the Archives at any time.    After this number is reached, the oldest item scrolls off each time a 
new item is added to the list, regardless of the History Entries Expire After setting.    If you prefer that the 
total number of URLs not be a factor in determining when items scroll off the Global History list, click in 
the box next to All.

Link Tree:  Maximum Number of Links
Using this field, you can specify the maximum number of items that should remain on the Link Tree page 
of the Archives pane at any time.    After this number is reached, the oldest item scrolls off each time a 
new item is added to the list, regardless of the History Entries Expire After setting.
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Global and Local History

To view the History pages:

1.      If the Archives pane is not visible on the left side of your display, click the Archives    button on 
the Toolbar.

2.    In the Archives pane, click the tab labeled Global History.

Assuming you have not changed the default setting for ‘History Entries Expire After’ on the Global
History page of the Preferences notebook, you will see a list of up to 500 URLs you have visited 
during the past seven days.

3.    Now click the Local History tab.

Displayed in the Archives pane is a list of the documents you have viewed in the current (foreground) 
browser window.    

If you click another window to bring it to the foreground, the Local History page changes to reflect the 
History of the new current window.    If no browser windows are open, the Local History page will be 
empty.    

The Global and Local History lists provide information you can use to create Hotlists -- collections of sites 
you might want to revisit in the future. 
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HTML Viewer

Display Inline Images
This feature allows you to view documents with or without inline images.    (Quarterdeck Mosaic supports 
inline display of .GIF, .JPG, and .XBM files.)    Most users want to take full advantage of the Web’s 
multimedia capabilities and will want to view graphics onscreen.    If you have a particularly slow Internet 
connection, however, you may prefer to view documents without graphics in order to improve 
performance.    To disable the display of inline images, click in the check box to remove the check.

Show Links URLs
By default, the URL of any link is displayed in the Status Bar when the cursor passes over the link.    If you
prefer not to have URLs shown in the Status Bar, click in the check box to remove the check.

Change Cursor Over Links
By default, the cursor changes from an arrow to a hand when it passes over a link.    If you prefer that the 
cursor not change shape when it moves over a link, click in the check box to remove the check.

Wait for Images
If this feature is enabled, Quarterdeck Mosaic waits to be told the size of an image before continuing to 
display a document.    If the feature is disabled, an icon is displayed in place of an inline graphic image, 
and the document is reformatted after information about the image is received.    When disabled, you will 
at times be able to read a document slightly sooner; however, your reading may be interrupted by the 
reformatting of the text.

Paragraph Spacing
This field determines the amount of space (in pixels) between paragraphs. 

Indent Width 
This field determines the amount of space (in pixels) at the beginning of indented lines.

Styles
These options determine the appearance of lists in which each item is prefaced by a number or bullet, 
respectively.    

Numbered Lists
Bullets

The following option allows you to change the way links are displayed on your screen.
Hypertext Links 
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Hardware and Software Requirements

In order to use Quarterdeck Mosaic and achieve acceptable performance, your system should include:

A 386 or better processor with at least 4 megs of RAM, 8 megs recommended.

A VGA (or better) graphics adapter.

2 megabytes of free hard disk space.    (Additional hard disk space required to download and 
save large files.)

Microsoft Windows 3.1 or higher.

Quarterdeck Winsock (or another properly configured Winsock driver).

A Modem (9600 baud minimum, 14400 or faster recommended) and a SLIP or PPP account with 
an Internet service provider.

or

Access to a network with a direct connection to the Internet.

Optionally:

A sound card and speakers (or headphones) for listening to sound files.

External viewers for viewing file types other than plain text, HTML, .GIF, .JPG, .XBM, .WAV, .AU, 
and .AIFF (which are supported internally by Quarterdeck Mosaic).
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Help Commands

Alt + H, C Displays the online help file, 
with the Table of Contents 
page visible.

Alt + H, S Displays the Search for Help 
On dialog box, which allows 
you to search the Help file for 
information related to specific 
topics.

Alt + H, H Displays the Microsoft 
Windows Winhelp online help
file, which explains how to 
use the Windows online help 
system.

Alt + H, A Displays version and 
copyright information and a 
list of the individuals who 
worked together to bring you 
Quarterdeck Mosaic, the Next
Generation Web Browser!
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Help Menu

Contents      [Alt+H, C]
Displays the online help file, with the Table of Contents page visible.

Search for Help On      [Alt+H, S]
Displays the Search for Help On dialog box, which allows you to search the Help file for information 
related to specific topics.

How to Use Help      [Alt+H, H]
Displays the Microsoft Windows Winhelp online help file, which explains how to use the Windows 
online help system.

About Quarterdeck Mosaic      [Alt+H, A]
Displays version and copyright information and a list of the individuals who worked together to bring 
you Quarterdeck Mosaic, the Next Generation Web Browser!
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Hotlist Commands

Alt + O, C Designates the Hotlist in the 
current browser window as 
the "Current Hotlist".

Alt + O, S Saves the current document 
to the "Current Hotlist".

Alt + O, I Extracts URLs from an HTML 
document or a hotlist 
generated by certain other 
browsers (such as Netscape 
or NCSA Mosaic) and places 
them into a newly created 
Quarterdeck Mosaic Hotlist 
folder within the "Current 
Hotlist" folder.

Alt + O, E Extracts URLs from a 
Quarterdeck Mosaic Hotlist 
folder and places them in a 
new HTML document.

Alt + O, H Creates a new Hotlist folder 
within the currently displayed 
Hotlist.

Alt + O, N Adds a new item to the 
currently displayed Hotlist.
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Hotlist Menu

Set As Current        [Alt+O, C]
Designates the Hotlist displayed in the current browser window as the Current Hotlist.    All 
documents that are Saved to Hotlist using the Hotlist button on the Toolbar or a document’s pop-up 
menu are placed in the current Hotlist.

Save to Current      [Alt+O, S]
Saves the current document within the current Hotlist.    This is equivalent to selecting Hotlist from the
Toolbar.

Import      [Alt+O, I]
Extracts URLs from an HTML document or a hotlist generated by certain other browsers (such as 
Netscape or NCSA Mosaic) and places them in a newly created Quarterdeck Mosaic Hotlist folder 
within the current Hotlist.

Export      [Alt+O, E]
Extracts URLs from the Quarterdeck Mosaic Hotlist folder displayed in the current browser window 
and places them into a newly created HTML document which can then be shared with other users of 
Quarterdeck Mosaic or other Web browsers.

New Hotlist      [Alt+O, H]
Creates a new Hotlist folder within the currently displayed Hotlist.

New Hotlist Item      [Alt+O, N]
Adds a new item to the currently displayed Hotlist. When you select this option, the File Properties 
dialog box is displayed.    After entering a URL and title (and, optionally, assigning an icon), then 
clicking OK, the new item is added to the current Hotlist.    
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Hotlists

The Hotlists page of the Archives is a storage place for all of your Hotlist folders, including a number of 
preconfigured Hotlists included with Quarterdeck Mosaic. You can easily add URLs to the Hotlists page or
any of its folders.

Note:      The Hotlists page is to URLs and Hotlists what the root directory is to your hard drive.    Your root 
directory can contain files or directories (groups of files); similarly, the Hotlists page can contain 
single URLs or folders of URLs that you have chosen to group together.    

To create a new Hotlist folder or URL on the Hotlists page or in any of its folders:

1.      Click on the Hotlists tab of the Archives to display your Hotlist folders.

2.      Click on the name of a Hotlist folder to display its contents in a browser window.

3.      Right click within the borders of the browser window to display the Hotlist’s pop-up menu, then 
select Current Document, then New, then Folder or URL.

To rename a folder or URL:

1.      Hold down the Alt key and click on the object’s name.

2.      Type in the new name, then press Enter or click outside the name.

or (for URLs only)

1.      Right click on the name or icon to display its pop-up menu.

2.      Select Properties.

3.      Type in a new name, then click OK.

To change the way Hotlists and URLs are displayed within a browser window:

1.      Right click within the open folder to display its pop-up menu.

2.      Select Current Document, then the arrangement you prefer:    Icons, Icons List, Text List, or 
Tree.

or

1.      Select View from the Menu bar, then select an arrangement.

Note:        Items are always listed in Tree view within the Archives.

To assign an icon to a folder or URL:

1.      Right click on the folder or URL.

2.      Select Current Document, then Properties from the menu that appears.



3.      Click on the Change Icon button.

4.      Select an icon from the collection shown or use the Browse button to search your drive for an 
appropriate icon, then click OK.

5.      Click OK to save your choice and close the Properties dialog box.

Note:        User-defined icons are only available within browser windows.    They are not visible within the 
Archives, where default mini-icons are used.    Also, they are only seen when items are 
represented by large icons, which is the case when you select ‘As Icons’ or ‘Icon List’ from the 
pop-up menu, and when browser windows are minimized to the Quarterdeck Mosaic desktop. 
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If you have been using another Web browser, you may have quite a collection of URLs.    Quarterdeck 
Mosaic saves you the trouble of re-entering all that information.    Our Import feature extracts URLs from 
HTML documents as well as Netscape and NCSA Mosaic Bookmarks and places the information in new 
Hotlist folders so you can visit all your favorite sites as soon as Quarterdeck Mosaic is installed!    You can
also export your Quarterdeck Mosaic hotlists for use by friends and co-workers.



Importing and Exporting URLs

If you have been using another Web browser, such as Netscape or NCSA Mosaic, you may have an 
extensive collection of URLs.    Netscape’s Bookmarks - their equivalent of Hotlists - are simply HTML 
documents in which URLs and their titles are stored, while NCSA Mosaic uses a    proprietary format to 
store favorite URLs.    Quarterdeck Mosaic allows you to easily extract this information from an NCSA 
Mosaic or Netscape Bookmark or any other HTML file and store it in a new Hotlist folder.    Newly created 
Hotlist folders are placed in the current Hotlist.

To import URLs from an NCSA Mosaic or Netscape Bookmark or an HTML file:

1.     Select a destination for your newly created Hotlists by designating one of your Hotlists as the 
"Current Hotlist."    (The procedure for setting a Current Hotlist is described earlier in this chapter.)

2.      Select Import from the Hotlist menu.

An Import dialog box appears.

3.      Specify the file you wish to import (such as BOOKMARK.HTM in the case of a Netscape 
Bookmark), then click OK.

A new Hotlist folder containing the extracted URLs is created within your Current Hotlist.    

Initially, the new folder is named after the file that was imported.    For instance, if you import the following 
Bookmark file:

C:\NETSCAPE\BOOKMARK.HTM

the folder will also be named C:\NETSCAPE\BOOKMARK.HTM.    You can change the name of a folder 
by holding down the Alt key and clicking the name, then typing in a new name.    

You can also export the URLs in a Quarterdeck Mosaic Hotlist to an HTML document or Quarterdeck 
Mosaic Hotlist folder.    This allows you to share the information contained in your Hotlists with others.

To export the URLs in a Quarterdeck Mosaic Hotlist:

1.      Display the Hotlist you wish to export in the current browser window.

2.      Select Export from the Hotlist menu.

The Export dialog box appears.

3.      Select the type of file you wish to create (either an HTML file or a Quarterdeck Mosaic folder),    
specify a name and directory for the new file, then click OK.

Quarterdeck Mosaic will create a file with the URLs contained in the Hotlist.    Note that only the URLs that
make up the top level of the Hotlist are exported.    If the Hotlist contains other Hotlist folders, you must 
repeat the steps above to export those URLs also.
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Introduction to Quarterdeck Mosaic

When you start up Quarterdeck Mosaic for the first time, a "Home Page" displays on your screen. This 
file, like most documents displayed by Web sites, is a hypertext document, created using a formatting 
language called HTML (or Hypertext Markup Language.)      Hypertext documents contain highlighted 
words and phrases called links.    When you click on a link, your browser retrieves the document 
associated with that link.    The new document might be located on the same computer system as the 
previous one, or it can reside on a system thousands of miles away.    

It is not necessary for you to understand HTML or to concern yourself with the physical locations of 
documents. Quarterdeck Mosaic reads and interprets the address -- called a URL, or Uniform Resource 
Locator -- and then retrieves the document for you with a simple click of your mouse. 

(Although Web browsers are most commonly used to access information over the Internet, Quarterdeck 
Mosaic is also an excellent tool for communicating within a corporate environment that has a Web Server!
This manual will focus on using Quarterdeck Mosaic with a live connection to the Internet, but you can 
use most of Quarterdeck Mosaic’s features when connected to a local Web server, within a Local Area 
Network.)
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Keyboard Commands

Within Quarterdeck Mosaic, you can perform tasks using either the mouse or one of the following key 
combinations.

File Commands
Edit Commands
View Object Commands
Navigate Commands
Hotlist Commands
Window Commands
Tools Commands
Help Commands



Link Tree 

The Link Tree page of the Archives gives you a road map of the hypertext links in the current browser 
window.    Documents are listed in a tree, with the current document at the top of the list.    Below are the 
links contained within the current document.    Once you visit a URL, Quarterdeck Mosaic remembers all 
of the links in that document for the length of time specified on the Global History page of the Preferences
notebook.

Each document is represented by a small paper icon.    Also shown is the title of the link.    If a document is
preceded by a plus (+) sign, it contains other links.    Click on the plus sign to expand the display and view
these additional links.    (When expanded, the plus sign changes to a minus (-) sign.    Click on the minus 
sign to contract the display.)

As with URLs listed in the History and Hotlists pages of the Archives, you can view any URL on the Link 
Tree page by clicking on it.    You can also save a URL to a Hotlist or save a document to disk by dragging
and dropping it on the appropriate Toolbar button.
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List of Features

Rather than simply enhance the original NCSA version of Mosaic, we rewrote it from scratch!    Not only 
did we add functionality, but we vastly improved its speed.    Our exciting new browser, redesigned from 
the ground up, includes the following features:

Faster Response 

Multiple Browser Windows

Quarterdeck Winsock

Location Manager

Hotlists

Import and Export Hotlists

Assign Icons to Hotlists and URLs 

History 

Gopher and FTP 

Newsgroups and Email
 
Drag and Drop 

Pop-Up Menus 

Customizable Toolbar 

Configurable Page Elements

URL Helper

Online Help 
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You can personalize your Hotlists and URLs by assigning the icon of your choice to any object.



Customize your browser windows by changing the background page color, font style and size, and other 
visual elements.



Use your mouse to drag and drop documents into a hotlist folder, display a document by dragging it from 
the History list to a browser window, and delete unwanted items by dragging them to the Trash Can.



Quarterdeck Mosaic’s cache is one of several features that improve Web response time, regardless of the
speed of your Internet connection.    Another enhancement is incremental display of documents, which 
allows you to view a document (and even access links in it) as the document is received by Quarterdeck 
Mosaic.



The ability to access and download from Gopher and FTP sites is seamlessly integrated into the program.



Quarterdeck Mosaic creates an electronic trail of sites you visit during your explorations, so you can 
quickly return to any site listed in the History. The Local History contains a list of sites from the current 
browser window, while the Global History lists places visited within a specified number of days.



Choose large or small buttons, with or without text, and decide where you want your Toolbar: top, bottom, 
right or left side, or floating on the screen.



Overlapping (multitasking) network access means you can download and view two or more documents 
simultaneously, in separate browser windows.



Find the information you need to maximize your productivity (and fun!) with Quarterdeck Mosaic’s 
extensive online help.



You can right click on folders, URLs, or within documents to bring up a menu from which you can perform 
common tasks with a click of the mouse.



Using the Location Manager, you can configure your Winsock driver to access one of several providers -- 
from one of several locations -- with a few mouse clicks.    For instance, if you use a notebook computer 
both at work and at home, you can set up two location profiles.    Then simply select the profile that 
matches your current location.



Quarterdeck Mosaic includes a Winsock driver and a dialer program that automatically calls your Internet 
provider whenever Quarterdeck Mosaic or another Winsock application makes a network request. 
Quarterdeck Winsock’s easy-to-use console window allows you to monitor network activity as you log on 
and log off. 



Step by step assistance in creating "legal" URLs is available at any time with Quarterdeck Mosaic’s 
unique URL Helper feature.



Quickly and easily save the locations of interesting documents you visit in Hotlist folders. Once a 
document’s location is stored in a hotlist, you do not have to remember complex URL addresses or the 
links you followed to get to it.    Just click its name or icon. By creating multiple hotlist folders you can 
organize documents in ways that make sense to you. Quarterdeck Mosaic comes preconfigured with 
several Hotlists of sites that we think you will find interesting.    



Local URLs

To load documents that reside on your local hard drive or drives that are accessible to you via a local area
network, select the scheme file, then enter the complete path and filename of the document you wish to 
view.    Quarterdeck Mosaic automatically adds the necessary scheme and host information to the name 
of the document to create a legal URL.    

For example, if you wanted to load a file called TESTING.HTM from a directory called DOCS on drive C:, 
you could either use the Browse button to select the file or enter the following in the Filename field of the 
URL Helper dialog box, using either upper or lower case:

C:\DOCS\TESTING.HTM

Quarterdeck Mosaic’s URL Helper would then create the following URL:

file://localhost/c|/docs/testing.htm

HTML documents that reside on DOS systems normally use the extension .htm while UNIX systems, 
which allow longer filenames, usually use the extension .html.    There is one other very important 
difference between URLs on DOS and UNIX systems.    Unlike DOS, UNIX is case-sensitive.    On a DOS 
system, myhome.htm and MYHOME.HTM refer to the same document.    Not so in UNIX.    Because most 
of the sites you will visit on the Internet exist on UNIX machines, make sure you get in the habit of typing 
URLs with the necessary mixture of uppercase and lowercase letters.    (The scheme portion of the URL - 
the characters that preceed :// - should always be lowercase.)

Return to Understanding URLs



If Make This Action Permanent is checked, Quarterdeck Mosaic will take this action in the future when it
encounters a file of this type.    If you want the action to pertain only to this particular file, remove the 
check from the checkbox.



Managing Documents

Quarterdeck Mosaic lets you add personal notes (called annotations) to your documents, save remote 
documents and    images to your local hard drive, display previously saved documents in browser 
windows, and print documents to any printer recognized by your Windows configuration.

Adding Annotations
Saving Documents to Disk
Saving Hypertext Links within Documents
Saving Images to Disk
Viewing Previously Saved Documents
Printing Documents



Mouse, Menus, or Keyboard?

Quarterdeck Mosaic allows you to retrieve, view, save, and print documents using a few simple 
techniques.    You need not be concerned whether the URL has been previously displayed (in which case 
it appears in purple text rather than blue) or whether it is listed in the Archives or in a browser window.    
All URLs, regardless of their location on your screen, can be manipulated as follows:

Drag and Drop:

        You can drag any item to one of the Toolbar buttons that functions as a Windows drop-site.    
(Drop-sites include the Hotlist, Save, and Trash buttons.)

        You can drag URLs from the pages of the Archives to the desktop area in order to view the 
documents in browser windows or drag documents (and links within documents) to the Archives 
to save them in a Hotlist.    

(If you drop a URL on an open browser window, the new document replaces the contents of that 
window.    If you drop it on an empty area of the desktop,    the document opens in a new window.)

Pop-Up Menus:

You can right click any item to display a pop-up menu and, from this menu, select the 
appropriate command.

Pull-Down Menus:

You can use the pull-down menus on the menu bar to perform actions which affect the current 
browser window.    

Keyboard Commands:

If you prefer, you can use keyboard commands to perform tasks within Quarterdeck Mosaic. 
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Navigate Commands
      

Alt + N, H 
[or Ctrl +
Home]

Loads the designated Home 
Page in the current browser 
window (or in a new window, 
if none is open.)

Alt + N, B 
[or Ctrl +
-]

Replaces the contents of the 
current browser window with 
the previously viewed 
document.

Alt + N, F 
[or Ctrl +
+]

After moving backward 
through documents in a 
browser window, moves 
forward to the next document 
that was viewed in the 
window.

Alt + N, G 
[or Ctrl +
G]

Retrieves and displays a URL
in the current window or, if 
none is open, in a new 
window.

Alt + N, S 
[or Ctrl +
Break]

Halts a document retrieval in 
progress.
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Navigate Menu

Home      [Alt+N, H] or [Ctrl+Home]
Replaces the contents of the current browser window with your designated Home Page.    This menu 
option is equivalent to the Home button on the Toolbar.    

Go Back      [Alt+N, B] or [Ctrl+-]
Replaces the contents of the current browser window with the previously viewed document.

Go Forward      [Alt+N, F] or [Ctrl++]
After moving backward through documents in a browser window, Go Forward moves forward to the 
next document that was shown in the window.    (Think of Go Forward as undoing a Go Back 
command.)

Go To      [Alt+N, G] or [Ctrl+G]
Replaces the contents of the current window with a URL you specify (unless you specifically request 
that the document open in a new window by clicking in the appropriate checkbox on the dialog).    This
option is equivalent to the Go To button on the Toolbar and Open on the File menu. 

Stop Current Read      [Alt+N, S] or [Ctrl+Break]
Halts a document retrieval in progress.    This option is equivalent to the Stop button on the Toolbar.
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Newsgroups

Newsgroups are online bulletin boards.    Anyone with access to the Internet can read and post messages 
(called articles) to any newsgroup carried by his or her provider.    Currently, over ten thousand 
newsgroups exist, and most service providers make several thousand of those available to their 
customers.    Most, but not all, newsgroups are part of a loosely-defined network called USENET.

So what do people talk about on newsgroups?    Anything and everything!    

You will, of course, find many groups dealing with computer-related subjects.    Look for groups that begin 
with comp, such as comp.os.ms-windows (Computers/Operating Systems/Microsoft Windows) or 
comp.os.msdos.desqview (Computers/Operating Systems/MS-DOS/DESQview).    Some groups are 
regional, with the name identifying the area involved, such as la.news or houston.general.    For 
recreational topics, check out groups beginning with rec, such as rec.skating or rec.food.restaurants. 

A large percentage of newsgroups fall into the alt (or alternative) category, where you will find discussions
on television shows, entertainers, current events, technical advances, religion, and ecology, to name just 
a few subjects.    You should be aware, however, that many newsgroups, particularly in the alt category, 
deal with adult topics and are completely unmoderated.    If you are offended by adult material or have 
children who are allowed to access the Internet, keep in mind that some newsgroups may not be to your 
liking or appropriate for the kids.

Reading Newsgroup Articles

Responding to Newsgroup Articles

Return to Advanced Navigation



Read and post to thousands of newsgroups -- Internet bulletin boards -- in which participants from all over
the globe discuss every subject under the sun!    You are sure to find more than a few that interest you.    
You can also send email messages to anyone with an Internet address from within Quarterdeck Mosaic. 



Overview

Welcome to Quarterdeck Mosaic, our new feature-packed Web browser!    We are certain that you will 
appreciate Quarterdeck Mosaic's speed, functionality, and ease of use as you explore the World Wide 
Web.    Although relatively new, the World Wide Web (often referred to as WWW or "the Web") is the 
fastest growing segment of the Internet, embraced by both commercial and individual users.    Because 
the Web is continually growing and changing, you are sure to visit new and exciting places each time you 
explore the Internet with Quarterdeck Mosaic.

Introduction to Quarterdeck Mosaic
Hardware and Software Requirements
List of Features
Components of Quarterdeck Mosaic



Personalizing Hotlists and URLs

It can be fun to customize a program by assigning your own icons to objects or altering the manner in 
which items are displayed.    Such flexibility can also make a program easier to use, by allowing you to 
work in the way you feel most comfortable.    Quarterdeck Mosaic allows you to personalize your Hotlist 
folders and URLs    in the following ways:

To rename a folder or URL:

1.      Hold down the Alt key and click the object’s name.

2.      Type in the new name, then press Enter or click outside the name.

You can also rename URLs by using pop-up menus:

1.      Right click the name or icon to display its menu.

2.      Select Properties.

3.      Type in a new name, then click OK.

Quarterdeck Mosaic gives you several ways to view Hotlist folders and URLs within browser windows.    
(Items are always listed in Tree view within the Archives.)

To change the way Hotlists and URLs are displayed in a window:

1.      Right click within the open folder to display its pop-up menu.

2.      Select Current Document, then the arrangement you prefer:    Icons, Icons List, Text List, or 
Tree.

Alternately, you can select View from the Menu bar, then select an arrangement.

To assign an icon to a Hotlist folder or URL:

1.      Right click the Hotlist folder or URL to display its pop-up menu.

2.      Select Current Document, then Properties from the menu that appears.

3.      Click the Change Icon button.

4.      Select an icon from the collection shown or use the Browse button to search your drive for an 
appropriate icon, then click OK.

5.      Click OK to save your choice and close the dialog box.

Note:        User-defined icons are only available when objects are viewed within browser windows and 
when they are represented by large icons. (Large icons are used when you choose the "As Icons"
or "Icon List" display method and when browser windows are minimized to the Quarterdeck 
Mosaic desktop.)    User-defined icons are not visible within the Archives, where the default mini-
icons are always used.    
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Printing Documents

To print the document in the current browser window:

1.      Select Print from the File menu, then click OK.

To print a document listed in the Archives:

1.      Click on the URL you wish to print.

Quarterdeck Mosaic displays the document in the current browser window.

2.      Select Print from the File menu, then click OK.

To see how a document will appear when printed:

1.      Select Print Preview from the File menu.

Return to Managing Documents



Properties Dialog Box

The File Properties dialog box shows the URL and its title, the date the URL was last accessed, and the 
MIME type (as indicated by the remote server).    Also displayed is the icon associated with the URL.

You can change the title by typing a new name into the Title field.    You can also assign a different icon to 
a URL by clicking the Change Icon button.



Reading Newsgroup Articles

Quarterdeck Mosaic allows you to access newsgroups just as you access other documents on the Web:    
by typing in the appropriate URL.    First, however, you must tell Quarterdeck Mosaic the name of your 
news server.    This information is specifed in the NNTP Server field on the Mail/News page in Location 
Manager.    (Many NNTP servers have names with "news." followed by the domain name, such as 
news.provider.com or news.provider.net.)

(To configure Location Manager, select Configure Network from the Tools menu. Help is available from 
any screen by clicking Help or pressing F1. If you need additional assistance with any field, ask your 
Network Administrator or Internet service provider.)

To access any of the newsgroups available through your provider:

1.     Select Go To from the Toolbar or Navigate menu.

The Go To URL dialog box appears.

2.     Type news:* and click OK.

A list of available newsgroups will be displayed in a browser window.    Depending on the speed of
your connection, it may take several minutes or longer for the entire list to appear. 

3.      Once you have retrieved a list of newsgroups you can see a list of the most recent messages 
posted to any group by clicking on its name. 

4.     Click any message to read it.

The command news:* in step two instructs the program to retrieve a list of all groups.    If you prefer, you 
can obtain a list of groups in a specific category by typing a prefix followed by an asterisk such as 
news:comp.* or news:alt.*.    The first command would retrieve the names of all newsgroups beginning 
with comp. and the second would retrieve the names of all alt. groups.    If you know the name of a 
specific newsgroup, you can retrieve it by typing its name, such as news:alt.music.james-taylor.    Any 
hypertext link to a newsgroup can be saved to a Hotlist.

Return to Newsgroups



Relative vs. Fully Qualified URLs

The author of an HTML document can enter URLs into a document in one of two ways.    The author might
include the scheme, host name, and file name or he or she might create documents embedded with 
relative URLs.      A relative URL includes only a filename or, in some cases, a directory and filename.    
When a user clicks on such a URL, the server software searches for the document based on the location 
of the base document.

If the Webmaster of www.qdeck.com used relative URLs, you might come across the following in a 
Quarterdeck HTML document:

Here is a plain text document.
Here is a hypertext document.
Here is a GIF image.
Here is an audio clip.

When viewing the source of the document, you would see this:

Here is a <A HREF = "basic.txt">plain text document</A><P>
Here is a <A HREF = "basic.htm">hypertext document</A><P>
Here is a <A HREF = "images/prism-sm.gif">GIF image</A><P>
Here is an <A HREF = "ring.au">audio clip</A><P>

If you are online and viewing a remote document, it does not matter whether the author uses fully 
qualified URLs or relative URLs.    It only becomes an issue if you save a document to your local system.   

When saving a document to disk, you must select a file type.    Quarterdeck Mosaic offers you three 
choices:    

As Is
HTML with Base
Plain Text 

When you select As Is, the document is saved with its HTML codes, but without information about the 
location of the base document. If you then load the saved document into Quarterdeck Mosaic and click 
one of its links, Quarterdeck Mosaic will be unable to access that URL if the author used relative URLs, 
because the scheme and host information is not included.    

By saving a document as HTML with Base, however, Quarterdeck Mosaic saves the base information 
that will allow you to navigate back to links contained in the document, even when the document is 
located on your drive. When you select Plain Text as the file type, only the text of the document is saved.   
Without its HTML codes, you will be unable to access links in the document regardless of whether the 
author used relative or fully qualified URLs.

Return to Understanding URLs



Responding to Newsgroup Articles

In addition to reading messages posted by others, Quarterdeck Mosaic lets you respond to them.    You 
can post a public response to a message that can be read by anyone with access to the newsgroup or 
send a private response to the author of a message.

To post a public message on a new subject:

1.     While viewing a list of newsgroup articles, click on Post to Newsgroup... at the top of the list. 

A document entitled Post: is displayed with the name of the newsgroup, your name, and the time 
and date filled in.    

2.      Enter an appropriate subject in the Subject field, then enter the body of your message in the 
Text field.

3.      When you are ready to send the message, click on Post It.

The message is sent off and posted to the newsgroup.

At any time prior to posting the message, you click on Reset Fields to remove the text you have 
entered from the Subject and Text fields.

To post a public response to an individual message:

1.    Click on Post Follow Up..., then follow steps 2 and 3 above.    

To send a private reply to the author of a message:

1.    Click on Reply to [author's name], then follow steps 2 and 3 above.
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Retracing Your Steps 

Quarterdeck Mosaic provides a simple way for you to move backward and forward through documents 
that have been displayed in a particular browser window.    When the initial document displayed in a 
window is replaced by a second document, an icon consisting of an arrow pointing to the left 
accompanied by the image of a page curled forward appears in the upper left corner of the document.    If 
you click this Page Turner icon, you are returned to the previous document.    After moving backward 
through a series of documents, a similar image (but with the page bent backward) appears in the upper 
right corner which allows you to move in a forward direction through documents that have appeared in 
this window.

Alternately, you can move backward or forward through the documents in a browser window by selecting 
Back and Forward from the Toolbar or the Navigate menu.

Note:      You might want to use separate windows when you need to refer to one document while working 
with another.    However, your display can become cluttered and confusing if too many windows 
are open.            
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Returning to Your Home Page

You can return directly to your designated Home Page at any time.    

To replace the contents of the current browser window with your Home Page:

1.      Select Home from the Toolbar or the Navigate menu.
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Saving Documents to Disk

As you explore the Web, you are likely to encounter documents you wish to save for future reference.    
Any document that you access via the Web can be saved to your local hard drive or a drive accessible to 
you over a local area network.    Quarterdeck Mosaic can save HTML documents in one of three formats:   
As Is, HTML with Base, and Plain Text.

As Is saves the document with HTML codes but does not save information about the base 
document.    

HTML with Base saves both HTML codes and information about the base document.    

Plain Text saves only the text; no HTML codes are included. 

For more information about file types and base document information, see Relative vs. Fully 
Qualified URLs.

To save the current document to disk:

1.      Select Save from the Toolbar or Save As from the File menu.

The Save As dialog box is displayed.

2.      Enter a filename, the location where you want to save the file, and a file type, then click OK.
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Saving Hypertext Links within Documents

You can also save a link within a document.    Quarterdeck Mosaic retrieves (but does not display)    the 
referenced document and allows you to save it to your hard disk, even though you are not currently 
viewing the document.    

To save a document that is linked to the current document:

1.      Right click the link itself and select Hypertext Link, then Save to Disk, from the link’s pop-up 
menu.

The Save As dialog box is displayed.

2.      Enter a filename, specify the location where you want to save the file and the file type of your 
choice, then click OK.
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Saving Images to Disk

Quarterdeck Mosaic allows you to save a .GIF, .JPG, or .XBM image contained in an HTML document 
without saving the entire document. 

To save an image in an HTML document:

1.      Right click the image itself and select Image Document, then Save to Disk, from the pop-up 
menu.

The Save As dialog box is displayed.

2.      Enter a filename, specify the location where you want to save the file and the file type of your 
choice, then click OK.

Images can be saved in their original format (by selecting the file type As Is) or in MS Windows Bitmap 
format (by selecting the file type Bitmap.)
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Saving URLs to Hotlist Folders

As you explore the Web you are sure to find many sites you will want to revisit in the future.    Quarterdeck
Mosaic makes it easy for you to save these URLs in just a few simple steps:

To save a URL from the Global History to a Hotlist:

1.      Click on a Hotlist to display its contents in a browser window.

2.      Select the Global history page by clicking on its tab.

3.      Drag the URL’s icon to the browser window in which the Hotlist is displayed and drop it on the 
desktop area (to add it to the collection shown) or on a specific folder to add it to a sub-folder (a 
Hotlist within the Hotlist.)    In the latter case, a box appears around the folder    when the cursor is
in the proper position to ‘drop’ the URL.

Note:    Because the contents of the Local history page change when the current document changes, you 
must follow a slightly different procedure when saving a URL from a Local history to a Hotlist.    In 
such case, either display the target Hotlist in the same browser window or display it in a new 
browser window, with both windows less than full screen and overlapping. Then drag the URL from
the Local history page of the Archives to the browser window containing the Hotlist.

To save the URL of a currently displayed document to a Hotlist:

1.      Make sure that the Hotlist is visible in the Archives pane.

2.      Place the cursor over the grey border around the document and, holding down the left mouse 
button, drag it to the Hotlist and release.    (As you drag the document, the cursor changes to an 
icon of a piece of paper.)

or

1.      Right click within the borders of the document to display the document’s pop-up menu.

2.      Select Current Document, then Save to Hotlist.

Using this method, the URL is saved to the ‘current’ Hotlist.

To save the URL of a hypertext link within a document to a Hotlist:

1.      Make sure that the Hotlist is visible in the Archives pane.

2.      Hold down the Control key and drag the link itself to the Hotlist.

or
 
1.      Right click on the link to display its pop-up menu.

2.      Select Hypertext Link, then Save to Hotlist.

Using this method, the URL is saved to the ‘current’ Hotlist.
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A remote system can use one of several schemes, or protocols, to communicate with other machines.    
Quarterdeck Mosaic must use the same protocol when transferring information to and from the remote 
system.    When you select a protocol by clicking on its radio button, the scheme name and some required
punctuation are inserted into the URL field.    Once you select a protocol, the other fields on the dialog box
change to reflect the additional information needed to complete the URL. 



If text is highlighted in the document, selecting Up causes Quarterdeck Mosaic to search from the 
beginning of the highlighted text to the beginning of the document and, if the string is not found, to 
continue searching from the end of the document up to the highlighted passage. 

Selecting Down when text is highlighted searches from the end of the highlighted text to the end of the 
document and, if the string is not found, from the beginning of the document down to the highlighted 
passage.    

If no next is highlighted, Up searches from the end of the document to the beginning and Down searches 
from the beginning to the end.



Searching the Web

An incredible amount of information is available on the Web, but that information will do you no good if 
you do not know where to find it.    Fortunately, there are many tools available to help you.    In fact, 
several search engines are accessible via the Quarterdeck Web site.

To utilize these valuable resources:

1.      Click Go To on the Toolbar.

The Go To URL dialog box appears.

2.      Enter the following URL:

http://www.qdeck.com/cusi.html

3.    Follow the on-screen directions to access the systems.    
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Sending Email Messages

When you post a private reply to the author of a newsgroup as described above, you are using the 
Internet protocol mailto:    You can use this protocol to send an email message to anyone with an Internet
address.    Quarterdeck Mosaic cannot retrieve and display email messages that are sent to you.    It can 
only send email.    In most cases, you will want to use a full-featured mail and news reader such as QMC 
(Quarterdeck Message Center).    You may, however, find it convenient to send an occasional email 
message while working in Quarterdeck Mosaic.

(Before you attempt to send email from Quarterdeck Mosaic, make sure that you have configured the 
Mail/News page of Location Manager with the appropriate mail server (SMTP Server) and your personal 
email address.    If you are not sure what to enter in these fields, check with your System Administrator or 
Service Provider.)

To send an email message:

1.      Select Go To on the Toolbar or Navigate menu, then click the URL Helper button on the Go To 
dialog box that appears.

2.      Click the radio button labeled mailto under Scheme, then enter the email address of the person
you are writing to and click OK.

The Go To dialog box is again visible.

3.      Click OK.

A document entitled Mail: is displayed with the To, From, and Date fields filled in.

4.      Enter an appropriate subject in the Subject field and enter the body of your message in the Text 
field.

5.      When you are ready to send your message, click on Mail It.
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Toggles the display of the Archives pane containing the Global and Local history lists, Hotlists, 
and Link Tree. 



Navigates backward to the document that brought you to the current document. If no previous documents 
are loaded, the Back button does not function.



After moving backward through documents in a browser window, the Forward button allows you to once 
again move forward through those same documents.    The Forward button functions only if you have 
previously navigated backward in the window.



Allows you to open a new document by typing in its URL (Uniform Resource Locator.) 



Returns you to the document designated as your Home Page. 



Saves the current document to the currently selected Hotlist.



Displays the Save As dialog box, allowing you to save the current document to a local drive.



Stops the current download/read activity.



Allows you to delete unwanted items from the Global or Local History or Hotlists.



Instructs Quarterdeck Mosaic to retrieve a new copy of the current document.    This is useful when a 
document is frequently updated or when Quarterdeck Mosaic is unable to display one or more graphic 
images in the document.



Taking That First Step

 1.    If the Archives pane is not displayed, click the Archives button to toggle it on.    

 2.    Click the Archives tab labeled Hotlists.

Your Hotlist folders are now displayed.

 3.    From the folders displayed, open the Reference folder by clicking on the plus sign [+] in front of 
it.

Each document in the Reference folder is now shown as a mini-icon followed by a text 
description.

 4.    Click Encyclopedia Britannica to select it.

The Home Page of Britannica Online, a subscription service that allows you to search the entire 
body of information contained in the Encyclopedia Britannica, is displayed ‘full screen’ in the 
desktop area.    Britannica Online is an example of the many searchable databases that can be 
accessed via the Web.

 5.    Click the words ‘Demo of Britannica Online’ which appear as blue, underlined text.

Congratulations!    You have just learned how to navigate the Web!    

Returning to our explorations, notice that the demo page has replaced the Britannica Online Home Page 
in the browser area.    If you prefer, you can open a new document in its own browser window rather than 
have it replace the current document.    Quarterdeck Mosaic is capable of "multitasking" -- performing 
network activity in more than one window at a time.    By displaying a document in a new window, you can 
download information into one window while working in another.    Keep in mind that your window must be 
unmaximized or you will not be able to view other open browser windows.

 6.    Click the Maximize/Restore button in the upper right corner of the display.    (This button, located
at the right end of the menu bar, consists of up and down arrows.)

The Demo of Britannica Online document now appears in a window rather than full screen.    The 
next step opens a document in a new browser window.

 7.    Hold down the Control key and click the words Quick Demo.    Without releasing the mouse 
button, drag the link to an empty area of Quarterdeck Mosaic’s desktop.

Notice that the words Quick Demo change into an icon of a piece of paper as you drag the link.    

 8.    When the piece of paper is over an empty area, release the mouse button to drop the document 
on the desktop.

The new document is seen in a new browser window, with the previous window also visible on 
the screen.    

 9.    Click Continue to jump to a page from which you can initiate a search -- in this case, a search 
for articles regarding Elizabethan Literature.



If you were a subscriber to this database, you would be able to view any of the thousands of 
articles it contains and, if desired, save them to disk for future use.    

10.    Without closing the current browsers, open the Entertainment folder on the Hotlists page by 
clicking on its plus sign.

11.    Now drag the Movies and Television icon from the Entertainment folder to an empty area of 
the desktop.

A list of databases involving movies and television opens in a new browser window.

12.    Select the first entry, Cardiff’s Movie Browser.

You now have Cardiff’s Movie Browser and Britannica Online displayed in separate browser 
windows.    
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The Archives

Quarterdeck Mosaic uses an area of its display called the Archives to record and display all of the sites 
you visit over a period of several days (seven days by default) as well as the sites you visit within a 
particular browser window.    The former is the Global History; the latter, the Local History.    Also available 
in the Archives is the Hotlists page containing your Hotlist folders and the Link Tree, a diagram showing 
the hotlinks associated with a document.    

Each of these features appears as a page within a notebook.    You can toggle the Archives display on and
off by clicking on the Archives button on the Toolbar or by selecting Archives from the View menu.

Viewing URLs Listed in the Archives
Global and Local History
Hotlists
Link Tree
Personalizing Hotlist Folders and URLs
Saving URLs to Hotlists
Importing and Exporting URLs



The Menu Bar

Along the top of the Quarterdeck Mosaic display are pull-down menus from which you can perform a wide
variety of tasks.    The actions associated with the menu options can also be accomplished through one or
more key combinations.    Below is a list of pull-down menus, the options available on each menu, and the
corresponding keyboard commands that can be used to perform each action.      Many of these tasks can 
also be performed via the Toolbar or pop-up menus.

File Menu
Edit Menu
View Menu
Navigate Menu
Hotlist Menu
Window Menu
Tools Menu
Help Menu



The URL Helper

You can use the URL Helper to construct a legal (syntactically correct) URL. (Note that the URL Helper 
does not verify that the address you enter is a valid one, only that the URL’s syntax is correct.) The Go To 
URL and Open URL dialog boxes include a URL Helper button.    Each browser window also includes the 
button, unless you have disabled it through the Preferences Notebook.

To create a URL using the URL Helper follow these steps:

1.      Click the URL Helper button.

The URL Helper dialog box appears.

2.     Select the appropriate protocol from the list entitled Scheme.

3.      Fill in the other fields that appear on the dialog box.

As you enter text in each field, it is added to the URL field.

4.      After entering all the necessary data, click OK.

Note:        You can only use the WAIS protocol if you are connecting to the Internet via a Proxy that 
supports WAIS.    Also, Telnet is only available if you purchased Quarterdeck’s suite of Internet 
tools and elected, during installation, to install QTerm, Quarterdeck’s Telnet applet.    
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Toolbar Button Drop-Sites

The Save button on the Toolbar provides a quick means of saving a document.      If you drag a document
from a browser window to this button, the document is saved to disk.    If you drag a URL from the 
Archives to the buttons, Quarterdeck Mosaic will first retrieve the document (from a remote system, if 
necessary) and then save it.    If you click the button with the mouse, the current document is saved.

By clicking the Hotlist button, you can instantly save the URL of the current document to a Hotlist.    If an 
item is dropped on the Hotlist button, that item is saved to the Hotlist you have specified as the "current" 
one.      

And finally, the Trash button on the Toolbar is used to prune the pages of the Archives.    When you want 
to remove URLs from the History pages or from a Hotlist, just drag the unwanted item to the Trash.

Tip:      In the upper-right corner of each browser window is an icon representing that document.    To
save a document to disk or to a Hotlist, drag the icon from the browser window to the 
appropriate Toolbar button.

Return to Exploring Quarterdeck Mosaic



Tools Commands
      

Alt + T, N Launches Location Manager 
and allows you to make 
changes to your network 
configuration.

Alt + T, F Launches QFTPW, 
Quarterdeck's graphical FTP 
applet.*

Alt + T, M Launches the Quarterdeck 
Message Center, a complete 
email and newsgroup 
management system.*

Alt + T, T Launches QTerm, 
Quarterdeck's terminal 
emulation applet.*

Alt + T, P Opens the Preferences 
Notebook, from which you 
can configure all facets of the 
program.*

*      This feature is only available with the complete Quarterdeck InternetSuite package.
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Tools Menu

Configure Network      [Alt+T, N]
Launches Location Manager and allows you to make changes to your network configuration.

FTP      [Alt+T, F]
Launches QFTPW, Quarterdeck's graphical FTP applet.    (This feature is only available with the 
Quarterdeck InternetSuite package.)

Mail/News      [Alt+T, M]
Launches the Quarterdeck Message Center, a complete email and newsgroup management system.   
(This feature is only available with the Quarterdeck InternetSuite package.)

Telnet      [Alt+T, T]
Launches QTerm, Quarterdeck's terminal emulation applet.    (This feature is only available with the 
Quarterdeck InternetSuite package.)

Preferences      [Alt+T, P]
Opens the Preferences Notebook, from which you can configure all facets of the program. 
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Troubleshooting

During installation, a Troubleshooting help file was installed in your Quarterdeck Internet program group. 
This file includes problem solving suggestions for all of the programs included with your software.

To view the file, double-click on the Troubleshooting icon in your Quarterdeck program group.



Type/Subtype
MIME (Multipurpose Internet Mail Extension) types are standard names used to describe data types.    On
this page, Type refers to the broad category to which this file type belongs, such as image, video, or text.   
Subtype is a more specific description.    For example, html and plain are both file types containing text 
only. Files with the subtype plain, however, would not contain html codes. 



Understanding URLs

Because there are times when you need to tell Quarterdeck Mosaic the exact address (URL) of a 
document you want to view or a site you want to visit, you should understand what a typical URL looks 
like.

Anatomy of a URL

Relative vs. Fully Qualified URLs

Local URLs

Return to Advanced Navigation



User Authentication Dialog Box

Some Web sites limit access to registered users.    When you attempt to connect to such a site, 
Quarterdeck Mosaic displays the above dialog box.

Enter the Name and Password you selected when you originally registered with the site, then press OK.  
(If you have not previously registered with the site, select Cancel.)



View Menu

As Icons      [Alt+V, I]
Displays Hotlist objects in the current window as rows of large icons, with a text description below 
each icon.    

As Icon List      [Alt+V, L]
Displays Hotlist objects in the current window as a list, with objects (folders and URLs) listed one per 
line, each represented by a large icon followed by a text description.    

As Text List      [Alt+V, X]
Arranges Hotlist objects in the current window as a list, with each folder or URL listed on a separate 
line represented by a miniature icon followed by a text description.    

As Tree      [Alt+V, T]
Displays Hotlist objects in the current window as a list, with each folder or URL represented by a 
miniature icon followed by a text description.    Preceding each miniature folder icon is a plus sign (+). 
When you click the plus sign, it changes to a minus sign (-) and the folder opens to display a list of all 
documents contained within it.    When you click the minus sign you collapse the tree, and the list of 
documents is no longer visible in the browser window.

Object Menu    [Alt+V, O]
Displays the pop-up menu for the object that has keyboard focus.    (See Switch Focus below.)

Document Source      [Alt+V, D]
Provides a split screen display with the current document viewed normally in the upper pane and with 
its HTML codes visible in the lower pane. This feature might be of particular interest to the advanced 
user who is involved in the creation and editing of HTML documents.

Toolbar      [Alt+V, B]
Toggles the display of the Toolbar on and off.

Archives      [Alt+V, A]
Toggles the display of the Archives pane containing the History lists, Hotlists, and Link Tree on and 
off.    This option performs the same function as the Archives button on the Toolbar.

Status Bar      [Alt+V, S]
Toggles the display of the Status Bar on and off.

Switch Focus      [Alt+V, F] or [F6}
Moves the keyboard focus among the following components of the Quarterdeck Mosaic display:    the 
current document, the URL field (if displayed in the current browser window), the document source 
window (if visible), annotations in the current document, and the Archives.

Return to The Menu Bar



View Object Commands
      

Alt + V, I Displays Hotlist objects in the 
current browser window as 
rows of large icons with text 
descriptions.

Alt + V, L Displays Hotlist objects in the 
current browser window as a 
list, one per line, with large 
icons and text descriptions.

Alt + V, X Displays Hotlist objects in the 
current browser window as a 
list, one per line, with 
miniature icons and text 
descriptions.

Alt + V, T Displays Hotlist objects in the 
current browser window as a 
list, one per line, with 
miniature icons and text 
descriptions.    In addition, 
each folder icon is preceeded
by a plus sign (+) that can be 
clicked to display its contents.

Alt + V, O Displays the pop-up menu for
the object that has keyboard 
focus.

Alt + V, O, A Adds a new annotation to a 
document with existing 
annotations.

Alt + V, D Views the current document 
in a split display, with the 
document viewed normally in 
the upper pane and with 
HTML codes visible in the 
lower pane.

Alt + V, B Toggles the display of the 
Toolbar on or off.

Alt + V, A Toggles the display of the 
Archives pane on or off.

Alt + V, S Toggles the display of the 
Status Bar on or off.

Alt + V, F    
[or F6]

Moves keyboard focus 
among the current document,



the browser window's URL 
field (if visible), the document 
source window (if visible), 
annotations in the current 
document, and the Archives 
pane.

Tab Moves among hypertext links 
in a document with keyboard 
focus.

Return to Keyboard Commands



Viewing Previously Saved Documents

Quarterdeck Mosaic can display HTML and plain text files that have been saved to disk, as well 
as .GIF, .JPG and .XBM images.    Quarterdeck Mosaic can also play .WAV, .AU, and .AIFF sound files.    
Other types of saved documents must be viewed with an external viewer capable of displaying that file 
type.    (Viewers need not be visual; they also include "players" capable of playing sound files.)

To view a file you previously saved to disk with Quarterdeck Mosaic:

1.      Select Go To from the Toolbar or the Navigation menu or Open from the File menu.

The Go To URL or Open URL dialog box appears.    

2.      Specify whether the document should open in a new window or replace the contents of the 
current window.    By default, the new document is displayed in the current window.

3.      Select Browse to search your drive for the file you want to view, then click OK.    

When HTML documents are saved, the HTML codes are saved in the document.    If the file is viewed 
within a Web browser, the codes are not visible and the file appears properly formatted.    If viewed with a 
text editor, the codes are visible, and the document is not properly formatted. 

Tip:      If you want to view multiple files, you can save time by highlighting the files in File Manager (or the 
file management component of an alternative shell such as Quarterdeck’s SideBar) and then 
dragging them to the desktop area.    Each document will be displayed in an individual browser 
window.

Return to Managing Documents



Viewing URLs Listed in the Archives

The easiest way to view a document listed in the Archives is to simply click its name.    Quarterdeck 
Mosaic will retrieve the document and display it in the current browser window.    If no windows are open, 
the document is displayed in a new window.    

Alternately, you can drag a URL from the Archives pane to an empty area of the Quarterdeck Mosaic 
desktop.    This action opens the document in a new window.

If you click a second URL before Quarterdeck Mosaic has finished retrieving the first, the first transfer is 
halted and the second document is retrieved.

Note:      When you want to view a document, the remote server tells Quarterdeck Mosaic what kind of file 
it is sending.    Quarterdeck Mosaic depends on this information when selecting the appropriate 
viewer for displaying the file.    If a document fails to display properly - for instance, if an HTML 
document displays with HTML codes visible or an executable (.EXE) file is displayed on the 
screen as jibberish when you attempt to retrieve it from a remote site - select Properties from the
File menu and look for MIME Type. Most likely the remote server has mistakenly told Quarterdeck
Mosaic to display the file as plain text.    Quarterdeck Mosaic must receive correct file type 
information from a remote site in order to properly handle a file.

Return to The Archives



Window Commands

Alt + W, D Creates an exact copy of the 
current browser window.

Alt + W, C Places open browser 
windows in the standard 
Windows Cascade 
arrangement.

Alt + W, T Places open browser 
windows in the standard 
Windows Tile arrangement.

Alt + W, O Closes all open browser 
windows.

Alt + W, A Aligns minimized windows in 
Quarterdeck Mosaic's 
desktop area.

Alt + W, H Causes the Archives pane to 
be displayed with your Hotlist 
folders visible.

Alt + W, G Causes the Archives pane to 
be displayed with the Global 
History pane visible.

Alt + W, L Causes the Archives pane to 
be displayed with the Local 
History pane visible.

Alt + W, K Causes the Archives pane to 
be displayed with the Link 
Tree page visible.

Alt + W, N Opens a window in which you
can monitor network activity.

Return to Keyboard Commands



Window Menu

Duplicate      [Alt+W, D]
Creates an exact copy of the current browser window.    This feature allows you to view a different 
section of the same document in each window or to follow links in one browser window while viewing 
the original document in another.

Cascade      [Alt+W, C]
Places open browser windows in the standard Windows Cascade arrangement in which windows 
overlap each other, with each window placed slightly lower and to the right of the previous window.

Tile      [Alt+W, T]
Places open browser windows in the standard Windows Tile arrangement, with each window taking 
up the same amount of space as the others and no window overlapping the others.

Close All      [Alt+W, O]
Closes all open browser windows.

Arrange Icons      [Alt+W, A]
Aligns any minimized windows in Quarterdeck Mosaic’s desktop area.    

Hotlists      [Alt+W, H] 
Causes the Archives pane to be displayed with your Hotlist folders visible.

Global History      [Alt+W, G]
Causes the Archives pane to be displayed with the Global History list visible.

Local History      [Alt+W, L]
Displays the Archives pane with the Local History list visible.

Link Tree    [Alt+W, K]
Displays the Archives pane with the Link Tree page visible.

Network Status      [Alt+W, N]
Opens a window in which you can monitor network activity. 

Return to The Menu Bar



As you can see, moving from one location to another is easily accomplished by clicking on these 
underlined ‘links’ that appear within documents.    Each link is an instruction that tells your browser to jump
to another location.    That location might be another position in the same document, another document 
that resides on the same computer system, or a document that exists on a different computer.    With a 
click of your mouse you can jump from a Web site in the United States to one in another country.    The 
best part is that you do not have to concern yourself at all with the physical locations of these documents!

By default, URLs are shown in blue (if they have not been visited within a user-configurable period of 
time) or purple, if they have.    This is true of URLs in the Archives as well as those displayed within 
browser windows.    You can configure the URLs to display in other colors on the Fonts page of the 
Preferences notebook.






